# Table of Contents

**Getting Started** ................................................................................................................................. 5  
Starting Lync 2010 ................................................................................................................................. 6  
Understanding the Lync 2010 Program Screen ...................................................................................... 7  
Using Help .................................................................................................................................................. 11  

**Voice and Video** ................................................................................................................................. 13  
Make a Phone Call .................................................................................................................................... 14  
Manage Calls ............................................................................................................................................ 15  
Voicemail and Missed Calls .................................................................................................................... 18  
Video Calls ................................................................................................................................................ 19  

**Instant Messaging** ............................................................................................................................... 21  
Create and Send Instant Messages ........................................................................................................... 22  
Format an Instant Message ....................................................................................................................... 23  
Receive an Instant Message .................................................................................................................... 24  

**Desktop and File Sharing** ................................................................................................................... 25  
Share your desktop .................................................................................................................................... 26  
Share Files ................................................................................................................................................ 28  

**Integration with Microsoft Outlook 2010** ........................................................................................... 29  
Outlook 2010 interoperability .................................................................................................................. 30
Getting Started

Microsoft Lync 2010 provides a single interface that unites voice communications, instant messaging, and audio/video/Web conferencing all at once.

**Find and communicate with the right person.** Presence including pictures, skill search, location information, and more. It gives users the context they need to make smart communication choices including built-in instant messaging capability.

**Create a more fun work environment by building social connections** The rich experience of Lync 2010 helps workers make connections across time and distance with picture-enhanced presence, automatic frequent contacts lists, and activity feeds for keeping up with co-workers.

**Make every interaction a near face-to-face meeting** Transform any conversation to include high-resolution video-, application-, and desktop-sharing and be fully present in meetings without making the physical trip.

**Communicate with context from Microsoft Office applications** Lync 2010 is consistent throughout Microsoft Office and other business applications, including color-coded presence icons, pictures, high-resolution video, and desktop sharing.

**Stay connected from virtually anywhere** A single experience across the PC, phone, or Web means that users have the choice to connect from many devices.
Starting Lync 2010

With Lync 2010, starting and signing in can be done in just a couple of steps.

Start Lync 2010 and Sign In

First, you must log on to the network.

1. Click Start, All Programs, Microsoft Lync, and Microsoft Lync 2010.
   The first time you are prompted to sign in.

2. In the Sign-in address box, enter your email address. The email address should be @illinois.edu rather than a department specific domain.

3. Click Sign In.
   To set up Lync 2010 to start automatically
   Click the Options button, Personal.
   Under My account, enter your email address
   Click the Automatically start Lync when I log on to Windows check box. Click OK.

Sign Out of Lync

You should leave Lync running in the background during your workday. Click the red X in the top right corner of the Lync window to remove the window from your desktop and place it on the taskbar at the bottom of the screen.

To exit (sign out of) Lync, choose one of these:

- Click File, Sign out on the menu bar at the top of the Lync program window.
- Click the availability menu directly under your name at the top of the Lync window and click Sign out.
- In the notification area of the taskbar, right-click the Lync icon and click Exit.

Lync Basics

Don’t see the menu bar in the Lync window?

Click the arrow to the right of the Options button and choose Show Menu Bar.

Note: this setting is stored locally on your computer. If you use a different computer you will need to reset.
Understanding the Lync 2010 Program Screen

**Me Area**

At the top of the Lync window is an area where you can see and modify the information about yourself that your contacts will see. Use the “Me Area” to:

- Show your status. Lync keeps track of how available you are, whether in a meeting, a call, or away from your desk. Your contacts will be able to see your presence status at a glance with red, yellow, and green indicators, as outlined in the table below. These presence indicators will also be visible in Outlook.

- Type a personal note. Display your status at a glance, whether business-related or just for fun.

- Customize your personal picture. You can change your picture from the default photo by choosing one of your own. Go to Lync Options, My Picture to set.

<table>
<thead>
<tr>
<th>Presence Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Available</strong></td>
<td>You are free to communicate.</td>
</tr>
<tr>
<td><strong>Busy</strong></td>
<td>You have started a Lync call or are doing a meeting.</td>
</tr>
<tr>
<td><strong>Do not disturb</strong></td>
<td>You have a meeting that you don’t want to be interrupted. You will receive notifications if they are sent by someone in your Workgroup.</td>
</tr>
<tr>
<td><strong>Be Right Back</strong></td>
<td>You are stepping away from your computer for a few moments.</td>
</tr>
<tr>
<td><strong>Away</strong></td>
<td>Your computer has been idle for a period of time (15 minutes by default).</td>
</tr>
<tr>
<td><strong>Off/Work</strong></td>
<td>You are not working and are not available to contact.</td>
</tr>
<tr>
<td><strong>Offline</strong></td>
<td>You are not signed in. If you have blocked individuals from seeing your presence, you’ll appear offline to them.</td>
</tr>
<tr>
<td><strong>Unknown</strong></td>
<td>Your presence is not known. If others are not using Lync as their instant messaging (IM) program, then your presence might appear unknown to them.</td>
</tr>
</tbody>
</table>

### Table 1-1: Presence Definitions

![Figure 1-4: Section in Lync main window containing personal information (Me Area).](image)

![Figure 1-5: View tabs for Contacts, Activity Feeds, Conversations, and Phone.](image)
**Contacts List**

The easiest way to find people is to look them up in the search box. You can search by name or phone number.

Start typing a name in the search box. The results will appear below the box. You can hover over the results and choose many options such as placing a call or adding them to your contact list or to a group of contacts in your list. You can also pin the contact name to your frequent contacts group.

Lync automatically populates your Frequent Contacts, based on the ten (10) contacts with which you most often have conversations.

You can set up a group for each team you work with so that you can see who is available at any given time or contact the entire team.

To set up a new group:

1. Right-click on a displayed group (such as Frequent Contacts),
2. Choose Create New Group.

To populate the new group, drag a contact into a group, or search for a contact, and, in the search results, right-click the person, click Add to Contacts List, and then click the new group name. If you wish to store a contact in more than one group, Ctrl-drag the contact name.

While hovering over a contact, a contact card will appear to the side of the program window. In the contact card, you can initiate an email or a chat session, place a call, or choose from a list of additional communication methods (such as place a video call, or schedule a face-to-face meeting), as well as share your desktop. To see more information about the contact, click the expand button at the bottom right corner of the contact card.

---

**Note**: you do not need to add a name to the contact list in order to communicate with them. Only add names to the list if you plan to communicate with them fairly regularly.

**Note**: if duplicate listings appear in the Search results, it may be displaying a contact you have stored in Outlook contacts along with from the Electronic Directory for campus.
If you wish to be notified when someone’s status has changed (out of a meeting or off the phone, for example), choose Tag for Status Change Alerts. Once set, a checkmark will appear next to this option until you deselect it. When the person being tagged becomes available, an alert window will appear in the lower right corner of your screen.

**Find a recent or missed conversation**

In the View Bar above the search box, click the **Conversations** icon.

Your recent incoming and outgoing instant messages and meetings, including ones you might have missed, appear in chronological order, with the most recent at the top. Recent phone calls you’ve had also appear on the **Conversations** list.

There are three filters at the top of the Conversation window:

- **All**: Shows 100 most recent conversations
- **Missed**: Shows any missed conversation during that timeframe (100 most recent)
- **Calls**: Shows any calls during that timeframe (100 most recent)

A complete list is maintained in the Outlook Inbox folder, Conversation History.

To change the settings for this option go to Lync options, Personal, and uncheck

For missed calls that resulted in voice mail, click the **Phone** icon on the View Bar.

![Figure 1-8: Tag for Status Change Alert.](image)

![Figure 1-9: Lync Options, Personal to change settings for storing conversations and call logs.](image)
View Activity Feeds

Activity Feeds lets you display to others your most recent personal notes, changes to your picture, to your title or office location.

1. Click the Activity Feeds icon.
2. Scroll through available feeds.

An asterisk (*) will appear on the Activity Feeds icon when there is an updated activity for one of the contacts in your contacts list. Once viewed, the * will disappear.

You can control whether the above information is shared by doing the following:

1. From the Tools menu, click Options.
2. On the Personal tab, under Activity Feed, switch the sharing of these updates on or off.

Note: Your current Out-of-Office note from Outlook will appear in the Activity Feed, if they are set.

3. Click OK.

Follow up on Voice Mail

Besides using the dial pad or the search box to enter a phone number to call, you can check for voice mail messages in the Phone view. It is here that you can play back voice mail; and reply by using chat or voice. A small circle will appear over the Phone icon containing the number of new voice mail messages left for you.

To listen to voice mail

1. Point to the voice mail listed, and then click the green arrow to listen to the message.

Options for voice mail settings are available by clicking the Voice Mail Options button at the bottom right corner of the dial pad.
Using Help

When you don’t know how to do something in Lync, look up your question in the Lync 2010 Help files. The Lync Help files can answer your questions, offer tips, and provide help for all of its features.

Browse for help

1. Click the Help menu at the top of the Lync program window.

   🔄 Other Ways to Open the Help Window:
   Press <F1>.

2. Click the category that you want to browse.

   The topics within the selected category appear.

   ☑ Tip: Click see all for a list of all help categories.

3. Click the topic that best matches what you are looking for.

For help with error messages or system-related issues, contact your IT Support staff or call CITES Help Desk at 217-244-7000 (or email consult@illinois.edu).

Figure 1-11: The Lync Help window.
Voice and Video

The Microsoft Lync 2010 client works with Microsoft Lync Server, providing a software-powered telephone.

Users can contact anyone inside or outside of their company. It is as comfortable as your old phone but a richer and more sophisticated experience.

Lync 2010 makes it easy to add video to a standard phone call in just one click. With enhanced support for audio and video devices, users can set up a video call in minutes. This is a simple way to improve collaboration among coworkers and customers.

Lync Enterprise Voice* supports the following types of calls:

- Computer to computer
- Computer to telephone
- Telephone to computer
- Computer to audio conference
- Video calls and conferencing

*Visit www.go.illinois.edu/myuc to view your account information (after logging in at the prompt).
Make a Phone Call

First let’s test the sound quality on your device:

1. Click Audio Device menu, Audio Device Settings.
2. Under Audio device, adjust the speaker, microphone and ringer.
3. Click the Check Call Quality button and verify the quality of the call by following the prompts to record and play back a test call quality check.
4. Set an additional ringer if you want more than one device to ring when you get an incoming call.
5. Click the OK button when finished.

Place a call

There are different methods for placing a call:

- In the Lync contacts list, click Call to place a computer to computer (Lync) call, or click the down arrow next to the Call button to choose a different call option (enter a new number, leave voicemail, etc.). You can also right-click the contact name and choose Call.
- Type in a telephone number in the search box under the View buttons.
- Enter a phone number by clicking the Phone icon on the view bar, and clicking the numbers on the dial pad. Finish by selecting Call (Figure 2-2).
- In Outlook 2010, hover over a name and click the call icon on the Contact Card.

Answer a Call

When a call notification window appears:

- Click the window to answer
- Decline the call to send to voicemail
- Redirect the call to send to another number.
Manage Calls

Conference Calls
Initiate a conference call or bring additional callers into an existing conversation.

1. To initiate a conference call from a contact list, single-click the first invitee and ctrl-click all additional invitees. Right-click one of the selected contacts and choose Start a Conference Call.

2. To invite another caller to an existing phone conversation, click the People Options button, Invite by Name or Phone Number.

Take Notes during a Conversation

You can take notes during a conversation using Microsoft OneNote and then send the notes to an email or another application such as Word.

1. In the conversation window, click the >> symbol to the right of the paper clip icon and choose take notes using OneNote.

2. OneNote will launch with the phone conversation as the note subject. Click in the note area, and type your notes.

3. To send notes, click File, Send and select the method you wish (email, Word, etc.)

During a call you can place it on hold or transfer the call to another number.

Put a call on hold

1. In the conversation window, click the hold button at the bottom right corner.

2. Click the Resume Call button on the yellow banner in the conversation window when you are ready to continue the conversation.
Transfer a call

To transfer to another person or number:

1. Click the drop down arrow next to the Transfer button at the bottom right corner of the conversation window.

2. Select the name or number to transfer to.

To transfer a call (announced) to another person:

1. Call the person getting the transferred call and announce the call (the original call will automatically be placed on hold).

2. Back in the call on hold window, click the Transfer button arrow, select Current Conversations, and click the conversation you wish to merge with this call.

Forward a call

You can send callers straight to voicemail or to another number or person to handle the call.

1. Click the phone icon at the bottom left corner of the Lync window.

2. Hover over Forward calls to and select a number (or type in a new number).

More call forwarding options can be set:

- Turning off call forwarding
- Forwarding calls to voice mail, a mobile phone, or other number
- Set simultaneous ring.

Team Calling

A team call group is a defined set of people who can answer your work calls. You can set this feature to ring you and your call group at the same time or at delayed intervals of 5 seconds, 10 seconds, or 15 seconds.

When a team member answers the call, the phones of all other members stop ringing. This feature is set in Lync Options, Call Forwarding.
Voice Options

Ringtones
To make changes to your ringtones:

1. In Lync, click the Options button and select Ringtones and Sounds.
2. In the Ringtone list, click the ringtone that you want. Lync will play a test tone for you. The volume of the ringtone should be adjusted on the device as applicable.
3. Select the ringtone desired for your own phone, or for other calling scenarios, as listed.
4. Click OK to save changes.

Sounds (Windows 7 only)

1. Click the Sound Settings button.
2. Click the Communications tab.
3. Set the sound (80% reduced is default) from speakers (music, etc.) that will be heard in incoming and outgoing calls.

Set an secondary ringer
You can select an additional ringer, if you want more than one device to ring when you get an incoming call. For example, you may want your computer speakers as well as your device to ring on an incoming call.

1. In Lync Options, click Audio Device. (or in the lower-left corner of the Lync window, click the audio device menu, and then click Audio Device Settings.)
2. Under Audio Device, select the Also ring check box, and then, from the drop-down list, select an additional device. You can also select the Unmute when my phone rings checkbox. Lync will then automatically unmute your speakers if there is an incoming call.
Voicemail and Missed Calls

Voicemail Options
1. To set options for your voicemail, click the Phone icon.
2. Below the dial pad, click the Display voicemail options menu.
3. Click Set up Voicemail. You will be taken to Outlook Web App where you will log in using your net id and AD password.
4. In the Web App screen that appears there are several different options you can set including call answering rules, greetings, Outlook voice access, resetting your PIN, notification settings (to send an email to your inbox or send a text message when you’ve missed a call).

Forward calls to Voicemail
1. Click the Call Forwarding button on bottom left corner of Lync window and then Call Forwarding Settings.
2. Click the option for Unanswered calls will go to, and change how many seconds to wait before sending incoming calls to voicemail.

Listen to Voicemail
1. Click the Phone icon in Lync and click Play.
2. From another phone device you can call 217-333-MAIL (6245) followed by your 10-digit campus number and PIN.

NOTE: Voicemail messages are emailed to your email inbox as an mp3 attachment.

Missed Calls
A missed call is created when someone calls and does not leave a voicemail message. Missed calls are tracked in the Conversations Menu in Lync.

You can also view your missed calls, voicemails, and instant message conversations directly from Outlook in the Conversation History folder in the inbox. This option can be disabled in Lync options, under the Personal settings, if desired.

It is also possible to be notified of a missed call by email or a text message if your Voicemail is set up for this option.
Video Calls

For the closest thing to a face-to-face conversation, use the Video Call feature in Lync.

If you have a webcam set up, you can choose to allow your contact to see you during your conversation.

Plug in a Webcam
In order to communicate in a video call you must first connect a webcam to your computer. Lync will automatically detect the webcam and use it for your next video call.

1. In Lync, click the Options button.
2. Click Video Device.
3. If your camera is correctly connected to your computer, the video picture is displayed. If you have another program open, such as your webcam program, you won’t see the video picture until you close that program.
4. If you have more than one video device and want to switch, select it from the drop-down list. If you have only one device connected, that is all that is displayed in the drop-down list.
5. To adjust any settings, including color balance, contrast, and brightness, and black-and-white mode, click the Webcam Settings button. Click OK when complete.

Now you’re ready to…

Add video to a conversation
In the Conversation window, click the Video button to start your webcam and initiate the video feature. The video call starts. You can continue to send instant messages to the call recipient and also to other contacts.

If you accept someone’s incoming video call, they will not see you unless you add video from your side of the conversation.

Exercise
Check video device settings. Initiate a conversation with someone in class and then start a video call. End conversation.
Accept a Video Call

If you don’t have a webcam you can view the caller’s video feed and the caller will see a video icon placeholder for your feed. The caller won’t see you unless you add your own video feed to the conversation.

1. In an open conversation window, caller initiates video. Lync will automatically display caller video in conversation window.
2. To display your webcam, click **Start my video**.
3. Click **View** to show a preview window or change webcam settings.

**Figure 2-16**: Initiating video call in a conversation

**Figure 2-17**: Start my video button to display webcam to caller

<table>
<thead>
<tr>
<th>Exercise</th>
</tr>
</thead>
<tbody>
<tr>
<td>Practice accepting a video call from someone in class.</td>
</tr>
</tbody>
</table>
The Internet has revolutionized the way we communicate. E-mail has been the most rapidly adopted form of communication ever known. Less than two decades ago, not many people had heard of it. Now, many of us e-mail instead of writing letters or even calling people on the phone. People around the world send out billions of e-mail messages every day.

But sometimes even e-mail isn't fast enough. You might not know if a person you want to e-mail is online at that moment. Also, if you're e-mailing back and forth with someone, you usually have to click through a few steps. This is why instant messaging (IM) has become so popular.
Create and Send Instant Messages

You can have instant messaging (IM) conversations with one or more contacts in Lync. You can also carry one more than one conversation at a time. You can choose the font type and characteristics, such as bold, underline, italics, and color for your message text. You can also insert emoticons and paste text and tables that you copied from other Microsoft Office programs, such as Word and Excel. You can escalate the conversation quickly into a phone call by clicking the Call button, or a Video call by clicking the Video button. You can attach a file by clicking the paper clip icon.

Send an Instant Message

To send an instant message to one person:

1. In the Lync program window, in your Contacts list or search results, double-click the person you want to get in touch with.
2. In the message input area, type a message, and then press Enter. You can tell when the other person is responding when an icon appears above the message input area showing that the person is typing a message.

To send separate instant messages to different people (at the same time):

1. Start an instant message conversation using steps 1-2 above.
2. Without closing the existing conversation, start a completely new conversation with another contact, number, or group.

End a Conversation

When you’re done with an IM conversation, click the Close button (X) in the upper-right corner of the Conversation window.

Exercise

Practice sending an instant message to someone in class. Make some format changes to your instant messages. Try out some emoticons.
Format an Instant Message

You can bold, italicize, underline, or change the font type, color, or size of a selection of text in the message input area of a current IM. You can also set options for all future instant messages.

Format message text for the current message

In the Conversation window, in the message input area, select the text that you want to format and do one of the following:

- Click the Formatting button (A) in the message input area, make the changes that you want, and then click the message area to accept the changes.

- Right-click the selected text, click Change IM Font, make the changes that you want, and then click OK.

Set text format for all future messages

1. In the Lync program window, click the Options button.

2. In Lync Options, click General.

3. Under Instant messages, click the Change Font button.

4. In the Change Your Font dialog box, select the options that you want, and click OK.

Add emoticons to instant messages

1. In the Conversation window, in the message input area, click where you want to add an emotion.

2. Click the Emoticon button (happy face), and then click the emoticon that you wish to add to the message.
Receive an Instant Message

When someone sends you an IM, an alert window appears in the lower-right corner of your computer screen. Do one of the following:

- Accept the invitation: click the alert
- Redirect the invitation: click Redirect
- Decline the invitation: click Ignore

Find a previous Instant Message conversation

Find a previous conversation with a specific contact by doing the following.

1. In your Contacts list, right-click the contact whose previous conversation you want to view.

2. Click Find Previous Conversations.

Outlook opens and displays that contact’s conversations in the Conversation History folder.

Exercise

Practice receiving an instant message from someone in class. Accept some, redirect one and decline one. Find a previous conversation.
Bring work and people together

With Lync 2010, you can connect and share your work directly from within Microsoft Office applications – send your document through Lync or share your desktop from Save & Send in the File Menu.
Share your desktop

Let everyone in a conversation view what is on your desktop.

1. In Lync, double-click a contact that you want to share with (or right-click the contact and choose Share, Desktop).

2. In the conversation window, click Share. If you have only one monitor, click Desktop. Otherwise, click the monitor that you want to share.

   When you are actively sharing, a bar is shown at the top of the window that reads **You are now sharing**. The meeting stage, in the right pane, shows a preview of what attendees are seeing, and a glow appears around the area being shared.

Choose an open program to share

1. In Lync, double-click a contact that you want to share with.

2. In the conversation window, click Share. Click Program.

3. In the Share Desktop or Applications dialog box, under Select applications you want to share, click the program that you want to show, and then click Share.

Stop sharing desktop or open program

1. On the sharing bar at the top of the screen, click Stop Sharing.

Give control to others

When you start sharing your desktop, a monitor, or a program, you’re the only one in control. You can also allow others to use their own mouse and keyboard to navigate and make
changes to whatever you’re sharing. You can take back control at any time.

On the sharing bar at the top of your screen, click the Give Control button, and then do one of the following:

- To allow anyone in the meeting to automatically take control of your computer, click Automatically accept control requests.

- To give control only to an individual, click the person’s name under Attendees.

⚠️ If you choose an individual, this person can immediately control your mouse and make edits using his or her keyboard. If you choose the Automatically accept control requests option, people will automatically get control when they click Request Control, on the sharing bar.

**Take back control**

To take back control, on the sharing bar at the top of your screen, click Give Control, and then click the selected option, either:

- Automatically accept control requests
- Take back control.
Share Files

There are a couple of ways in which to share files using Lync.

Send a file

From within Lync, in a conversation window:

1. Click the paperclip icon in the top right-hand corner of the window, navigate to where the file is you wish to share and click Open.
2. Click and drag a file from a list of files on your computer (or a desktop shortcut) to the open instant message window.

From within a Microsoft application:

1. With a document open in the application, click on the File tab on the Ribbon and choose Save and Send.
2. Select Instant Message and complete the information in the Send by Instant Message dialog box.
3. Click Send IM.

Receive a file

1. Click on alert window for new instant message.
2. Double-click the long rectangular button to start the file transfer.
3. After a few seconds the conversation window will display a message notifying you of the successful transfer of the file being shared. It will also suggest that you scan the file with an anti-virus program before opening it.
Integration with Microsoft Outlook 2010

With richer integration of Microsoft Lync 2010 than was available in earlier versions of Outlook, you can start live conversations from Outlook 2010. Hover over a name, see a person’s availability and then easily start a conversation directly through instant messaging, voice call, or video.
Outlook 2010 interoperability

We spend a lot of time in e-mail. With the integration between Outlook 2010 and Lync 2010, you should notice presence indicators next to addressee names in Outlook contact lists, received emails and calendar entries.

Presence indicators

Whether you are inviting someone to a meeting using Outlook calendar or receiving an email in your Inbox, the presence indicators that we first noticed in the Lync program window and contacts list are displayed.

To take advantage of Lync 2010 features while in Outlook:

1. Right-click on the name of the contact.
2. Choose an option from the menu that appears.

Notice that by right-clicking you can view availability, send mail, add to Lync contacts, send an IM, or tag for presence alerts.

Hovering over the name will display the contact card for that person where you can also choose various ways to communicate.

Respond Area

Another way to make use of Lync’s features is on the Outlook Ribbon, Home tab, Respond.

With an email selected from the Inbox, click the More command to call the addressee instead of replying by email.

Lync Contacts list in the Outlook To-Do Bar

Phone calls, Video calls, instant messages, desktop sharing and more can be initiated from within Outlook 2010 hovering over a contact in the Contacts list displayed in the Outlook 2010 To-Do Bar.